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Chapter 275

Tests for Two
Independent
Sensitivities
Introduction
This procedure gives power or required sample size for comparing two diagnostic tests when the outcome is
sensitivity (or specificity). In this design, the outcome of each of two diagnostic screening tests is compared to a
gold standard.
Specifically, a set of n subjects is randomly divided into two groups. In each group, a portion of the subjects have
the disease (condition of interest) and a portion does not. Each subject is given the one of the diagnostic tests.
Subsequently, a gold standard test is used to obtain the true presence or absence of the disease. The gold standard
may be a more expensive test, difficult to determine, or require the sacrifice of the subject.
The measures of diagnostic accuracy are sensitivity and specificity. Sensitivity (Se) is the probability that the
diagnostic test is positive for the disease, given that the subject actually has the disease. Specificity (Sp) is the
probability that the diagnostic test is negative, given that the subject does not have the disease. Mathematically,
Sensitivity = Pr(+test|disease)
Specificity = Pr(-test|no disease)
Li and Fine (2004) present sample size methodology for testing sensitivity and specificity using a two-group,
prospective design. Their methodology is used here. Other useful references are Obuchowski and Zhou (2002),
Machin, Campbell, Tan, and Tan (2009), and Zhou, Obuchowski, and McClish (2002).

Prospective Study Design
In a two-group, prospective study, a group of n subjects is split into two groups: those that receive diagnostic test
1 and those that receive diagnostic test 2. Each of these groups is divided further into those with the disease of
interest and those without it. Suppose that the k th group (k = 1 or 2) has nk 1 with the disease and nk 2 without the
disease. A diagnostic test is administered to each subject (usually before the disease status is determined) and its
output is recorded. The diagnostic test outcome is either positive or negative for the disease. Suppose that in the
nk 1 subjects with the disease, sk 1 have a positive test outcome and sk 2 have a negative outcome. Similarly, in the

nk 2 subjects without the disease rk 1 have positive outcomes and rk 2 have negative outcomes. Sensitivity in each
group is estimated by sk 1 / nk 1 and specificity is estimated by rk 2 / nk 2 . A useful diagnostic test has high values of
both Se and Sp.
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Conditional on the values of nk 1 and nk 2 , sk 1 is Binomial (nk 1 , Sek ) . Thus, a one-sided test of the statistical
hypothesis H 0 : Se1 = Se2 versus Se1 < Se2 can be carried out using any of the two-sample proportion tests
(see chapter 200 for more details on two-sample proportion tests). The power analysis of these tests follows the
same pattern as other two-sample proportion tests, except that the disease prevalence in the two groups must be
accounted for.
Specificity
This procedure computes the sample size for sensitivity. If you want a power analysis or sample size for
specificity, you can use this procedure with the following minor adjustments.
1. Replace Se with Sp in all entries.
2. Replace the disease prevalence with 1 – prevalence. That is, the prevalence becomes the proportion
without the disease.

Comparing Two Sensitivities
When analyzing the data from studies such as this, one usually compares the two binomial sensitivities, Se1 and

Se2 . Note that these values are estimated solely by the subjects with the disease. The data for those subjects
without the disease is ignored. The data is displayed in a 2-by-2 contingency table as follows
Test Outcome
Group Positive
1
s11

Negative

Total

s12

n11

s21

s22

n21

2

A popular test statistic for comparing the sensitivities is Fisher’s Exact Test or the Chi-square Test with one
degree of freedom.

Power Calculation
The power for a test statistic that is based on the normal approximation can be computed exactly using two
binomial distributions. The following steps are taken to compute the power of such a test.
1. Find the critical value (or values in the case of a two-sided test) using the standard normal distribution. The
critical value, zcritical , is that value of z that leaves exactly the target value of alpha in the appropriate tail of
the normal distribution. For example, for an upper-tailed test with a target alpha of 0.05, the critical value is
1.645.
2. Compute the value of the test statistic, zt , for every combination of s11 and s21 . A small value (around
0.0001) can be added to the zero cell counts to avoid numerical problems that occur when the cell value is
zero.
3. If zt > z critical , the combination is in the rejection region. Call all combinations of s11 and s21 that lead to a
rejection the set A.
4. Compute the power for given values of Se1 and Se2 as

n 
n −s
n −s  n 
1 − β = ∑  11  Se1s11 (1 − Se1 ) 11 11  21  Se2s21 (1 − Se2 ) 21 21
A  s11 
 s21 
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5. Compute the actual value of alpha achieved by the design by substituting Se1 for Se2 in the above formula

 n11  s11
n −s  n 
n −s
 Se1 (1 − Se1 ) 11 11  21  Se1s21 (1 − Se1 ) 21 21
s
s
 21 
 11 

α * = ∑ 
A

When the sample sizes are large (say over 200), these formulas may take a little time to evaluate. In this case, a
large sample approximation may be used.

Test Statistics
Various test statistics are available. The formulas for their power are given in Chapter 200 and they are not
repeated here. The test statistics are

Fisher’s Exact Test
The most useful reference we found for power analysis of Fisher’s Exact test was in the StatXact 5 (2001)
documentation. The material presented here is summarized from Section 26.3 (pages 866 – 870) of the StatXact-5
documentation. In this case, the test statistic is

  n1   n2  
    
 x   x2  
T = − ln  1
  N 
   
  m 

Chi-Square Test (Pooled and Unpooled)
This test statistic was first proposed by Karl Pearson in 1900. Although this test is usually expressed directly as a
Chi-Square statistic, it is expressed here as a z statistic so that it can be more easily used for one-sided hypothesis
testing.
Both pooled and unpooled versions of this test have been discussed in the statistical literature. The pooling refers
to the way in which the standard error is estimated. In the pooled version, the two proportions are averaged, and
only one proportion is used to estimate the standard error. In the unpooled version, the two proportions are used
separately.
The formula for the test statistic is

zt =

p 1 − p 2
σ D

Pooled Version

σ D =

1 1
p (1 − p ) + 
 n1 n2 

p =

n1 p1 + n2 p 2
n1 + n2

Unpooled Version

σ D =

p 1 (1 − p 1 ) p 2 (1 − p 2 )
+
n1
n2
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Chi-Square Test with Continuity Correction
Frank Yates is credited with proposing a correction to the Pearson Chi-Square test for the lack of continuity in the
binomial distribution. However, the correction was in common use when he proposed it in 1922.
Both pooled and unpooled versions of this test have been discussed in the statistical literature. The pooling refers
to the way in which the standard error is estimated. In the pooled version, the two proportions are averaged, and
only one proportion is used to estimate the standard error. In the unpooled version, the two proportions are used
separately.
The continuity corrected z-test is

F1
1
 + 
2  n1 n2 
σ D

( p1 − p 2 ) +
z=

where F is -1 for lower-tailed, 1 for upper-tailed, and both -1 and 1 for two-sided hypotheses.
Pooled Version

σ D =

1 1
p (1 − p ) + 
 n1 n2 

p =

n1 p1 + n2 p 2
n1 + n2

Unpooled Version

σ D =

p 1 (1 − p 1 ) p 2 (1 − p 2 )
+
n2
n1

Conditional Mantel Haenszel Test
The conditional Mantel Haenszel test, see Lachin (2000) page 40, is based on the index frequency, x11 , from the
2x2 table. The formula for the z-statistic is

z=

x11 − E ( x11 )
Vc ( x11 )

where

n1m1
N
nn mm
Vc ( x11 ) = 12 2 1 2
N ( N − 1)
E ( x11 ) =

Likelihood Ratio Test
In 1935, Wilks showed that the following quantity has a chi-square distribution with one degree of freedom.
Using this test statistic to compare proportions is presented, among other places, in Upton (1982). The likelihood
ratio test statistic is computed as

a ln(a ) + b ln(b) + c ln(c) + d ln( d ) +

LR = 2

 N ln( N ) − s ln( s) − f ln( f ) − m ln( m) − n ln( n)
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the sensitivities, specificities, sample
sizes, alphas, and powers.

Solve For
Solve For
This option specifies the parameter to be solved for using the other parameters. The parameters that may be
selected are Se2, Power, Sample Size (N1), and Sample Size (N2). Under most situations, you will select either
Power or Sample Size (N1).

Test
Alternative Hypothesis (H1)
Specify the alternative hypothesis of the test. Usually, the two-sided (“≠”) option is selected.
Note that the “<” and “>” options are one-sided tests. When you choose one of these, you must make sure that the
other settings (i.e. Solve For and Effect Size) are consistent with this choice.
Test Type
Specify which test statistic will be used in searching and reporting.
Note that “C.C.” is an abbreviation for Continuity Correction. This refers to the adding or subtracting 2/(N1+N2)
to (or from) the numerator of the z-value to bring the normal approximation closer to the binomial distribution.

Power and Alpha
Power
This option specifies one or more values for the desired power. Power is the probability of rejecting a false null
hypothesis, and is equal to 1- Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is commonly used.
A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. For this procedure, a type-I error occurs when you reject the null hypothesis of equal
sensitivities when in fact they are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha and this is still the
most common choice today.
Note that because of the discrete nature of the binomial distribution, the alpha level rarely will be achieved
exactly.
A single value may be entered here or a range of values such as 0.05 to 0.2 by 0.05 may be entered.
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Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N1, solve for N2
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1, solve for N2”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
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For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.
P (Prevalence)
Specify one or more values for the disease prevalence: the anticipated proportion of the population of interest that
has the disease. Because this is a proportion all values must be between zero and one.
You may enter a single value or a range of values such as 0.1, 0.2, 0.3.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
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N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.
P (Prevalence)
Specify one or more values for the disease prevalence: the anticipated proportion of the population of interest that
has the disease. Because this is a proportion all values must be between zero and one.
You may enter a single value or a range of values such as 0.1, 0.2, 0.3.
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Effect Size
Se1 (Sensitivity Groups 1 and 2|H0)
Enter the value of Se1 which is the sensitivity in both groups assumed by the null hypothesis, H0. The detectable
difference detected by this design is Se1 - Se2.
Note: Sensitivity = Pr(+Test|Disease).
Range
All sensitivities must be between zero and one.
You may enter a list of values such as 0.5, 0.6, 0.7 or 0.5 to 0.8 by 0.1.
Se2 (Sensitivity Group 2|H1)
Enter the value of Se2 which is the sensitivity in group 2 assumed by the alternative hypothesis, H1. The
detectable difference detected by this design is Se1 - Se2.
Note: Sensitivity = Pr(+Test|Disease).
Range
All sensitivities must be between zero and one. Also, this value cannot be set equal to Se0.
You may enter a list of values such as 0.5, 0.6, 0.7 or 0.5 to 0.8 by 0.1.

Options Tab
The Options tab allows for specification of various calculation parameters.

Zero Counts
Zero Count Adjustment Method
Zero cell counts often cause calculation problems. To compensate for this, a small value (called the Zero Count
Adjustment Value) can be added either to all cells or to all cells with zero counts. This option specifies whether
you want to use the adjustment and which type of adjustment you want to use. We recommend that you use the
option Add to zero cells only.
Zero cell values often do not occur in practice. However, since power calculations are based on total enumeration,
they will occur in power and sample size estimation.
Adding a small value is controversial, but can be necessary for computational considerations. Statisticians have
recommended adding various fractions to zero counts. We have found that adding 0.0001 seems to work well.
Zero Count Adjustment Value
Zero cell counts cause many calculation problems when computing power or sample size. To compensate for this,
a small value may be added either to all cells or to all zero cells. This value indicates the amount that is added. We
have found that 0.0001 works well.
Be warned that the value of the ratio and the odds ratio will be affected by the amount specified here!

Exact Test Options
Maximum N1 or N2 for Exact Calculations
When either [N1(P)] or [N2(P)] is above this amount, power calculations are based on the normal approximation
to the binomial. In this case, the actual value of alpha is not calculated. Currently, for three-gigahertz computers, a
value near 200 is reasonable. As computers increase in speed, this number may be increased.
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Example 1 – Finding the Power
Suppose that diagnosing a certain disease has used a certain diagnostic test which has a sensitivity of 71%. A new
diagnostic test has been developed that is much less expensive and invasive. Researchers want to design a
prospective study to compare the old and new tests using a two-sided Z Test with a significance level of 0.05.
They want to consider changes in sensitivity of 10%, 15%, 20%, and 25%. These changes translate to sensitivities
of 79.20%, 81.65%, 85.20%, and 88.75%. The prevalence of the disease in the population of interest is 20%. The
power will be determined for trials with sample sizes between 300 and 3000 incremented by 300.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Independent Sensitivities procedure window by expanding Proportions,
clicking on Sensitivity and Specificity, and then clicking on Tests for Two Independent Sensitivities. You may
then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing
Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis (H1) .................... H1: Se1 ≠ Se2
Test Type ................................................ Z Test (Pooled)
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 300 to 3000 by 300
P (Prevalence) ........................................ 0.2
Se1 (Sensitivity Groups 1 and 2|H0) ...... 0.71
Se2 (Sensitivity Group 2|H1) .................. 0.792 0.8165 0.852 0.8875

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for testing H0: Se1 = Se2 vs. H1: Se1 ≠ Se2
Test Statistic: Z test with pooled variance

Power
0.1840
0.3112
0.4358
0.5469
0.6421
0.7213
.
.
.

------- Sample Size ------N1
N2
N
300
300
600
600
600
1200
900
900
1800
1200
1200
2400
1500
1500
3000
1800
1800
3600
.
.
.
.
.
.
.
.
.

----- Sensitivity ----Se1
Se2
0.7100
0.7920
0.7100
0.7920
0.7100
0.7920
0.7100
0.7920
0.7100
0.7920
0.7100
0.7920
.
.
.
.
.
.

Prevalence
0.2000
0.2000
0.2000
0.2000
0.2000
0.2000
.
.
.

Target
Alpha
0.0500
0.0500
0.0500
0.0500
0.0500
0.0500
.
.
.

Actual
Alpha
0.0505

.
.
.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
Se1 is the sensitivity of groups 1 and 2 assuming H0.
Se2 is the sensitivity for group 2 assuming H1.
Prevalence is proportion of the population that actually has the condition (disease) of interest.
Target Alpha is the input probability of rejecting a true null hypothesis. Actual Alpha is the value of alpha
that is actually achieved.
Summary Statements
Group sample sizes of 300 in group 1 and 300 in group 2 achieve 18% power to detect the change
in group 2 sensitivity from 0.7100 under the null hypothesis to 0.7920 under the alternative
hypothesis. The sensitivity in group 1 is assumed to be 0.7100 in both cases. The test
statistic used is the two-sided Z test with pooled variance. The significance level of the test
was targeted at 0.0500. The significance level actually achieved by this design is 0.0505. The
prevalence of the disease (or condition of interest) is 0.2000.

This report shows the values of each of the parameters, one scenario per row. Because of the discrete nature of the
binomial distribution, the stated (Target) alpha is usually unequal to the actual alpha. Hence, we also show the
Actual Alpha along with the rejection region. Note that the actual alpha is only computed when the effective
sample size is greater than 100.
Power
This is the power of the test.
N1 and N2
These are the group sample sizes. The number of diseased subjects in each group is N1 x P.
Se1
This is the sensitivity of both groups assuming H0. The sensitivity is the proportion of diseased subjects that yield
a positive test result.
Se2
This is the sensitivity of group 2 assuming H1. The difference between Se1 and Se2 is the difference that is
detected by the study.
Target Alpha
This is the alpha (probability of rejecting H0 when H0 is true) that was desired. Because the binomial is a discrete
distribution, the target value is seldom obtained.
Actual Alpha
This is the alpha that was actually achieved by the test, calculated from the binomial distribution.
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P
This is proportion of the population that actually has the condition (disease) of interest, called the
prevalence.

Plots Section

These plots show the relationship between power, sample size, and Se2 in this example.
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Example 2 – Finding the Sample Size
Continuing with Example 1, suppose you want to study the impact of various choices for Se2 on sample size.
Using a significance level of 0.05 and 90% power, find the sample size when Se2 is 79.20%, 81.65%, 85.20%,
and 88.75%. Assume a two-tailed test is used.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Independent Sensitivities procedure window by expanding Proportions,
clicking on Sensitivity and Specificity, and then clicking on Tests for Two Independent Sensitivities. You may
then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing
Open Example Template.
Option

Value

Solve For ................................................ Sample Size
Alternative Hypothesis (H1) .................... H1: Se1 ≠ Se2
Test Type ................................................ Z Test (Pooled)
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
P (Prevalence) ........................................ 0.2
Se1 (Sensitivity Groups 1 and 2|H0) ...... 0.71
Se2 (Sensitivity Group 2|H1) .................. 0.792 0.8165 0.852 0.8875

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for testing H0: Se1 = Se2 vs. H1: Se1 ≠ Se2
Test Statistic: Z test with pooled variance
Target
Power
0.90
0.90
0.90
0.90

Actual
Power
0.90031
0.90024
0.90134
0.90237

N1
2915
1665
885
530

N2
2915
1665
885
530

N
5830
3330
1770
1060

Sens. 1
0.7100
0.7100
0.7100
0.7100

Sens. 2
0.7920
0.8165
0.8520
0.8875

Prevalence
0.2000
0.2000
0.2000
0.2000

Target
Alpha
0.0500
0.0500
0.0500
0.0500

Actual
Alpha

This report shows the sample size needed to achieve 90% power for each value of Se2.
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Example 3 – Validation using Machin and Campbell (2009)
Machin, et al (2009) page 166-167 give the results of a sample size determination in which Se1 = 0.27, Se2 =
0.66, P = 0.25, alpha = 0.05 (two-sided), and power = 0.80. The resulting sample size is 98 per group or 196 total.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Independent Sensitivities procedure window by expanding Proportions,
clicking on Sensitivity and Specificity, and then clicking on Tests for Two Independent Sensitivities. You may
then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing
Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis (H1) .................... H1: Se1 ≠ Se2
Test Type ................................................ Z Test (Pooled)
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
P (Prevalence) ........................................ 0.25
Se1 (Sensitivity Groups 1 and 2|H0) ...... 0.27
Se2 (Sensitivity Group 2|H1) .................. 0.66

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for testing H0: Se1 = Se2 vs. H1: Se1 ≠ Se2
Test Statistic: Z test with pooled variance
Target Actual
Power Power
0.80
0.81699

N1
96

N2
96

N
192

Sens. 1
0.2700

Sens. 2
0.6600

Prevalence
0.2500

Target
Alpha
0.0500

Actual
Alpha
0.0520

PASS has also obtained an N of 192 which is slightly different from 196 in the book. This difference is probably
the result of the exact binomial calculation used by PASS.
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